
Use Word 6.0c or later to           

view Macintosh picture.             

Use Word 6.0c or later to           

view Macintosh picture.             

Written By

Hussam A Dandashli
319 Gage Ave

Elkhart, IN 46516
e-mail: hussamd@skyenet.net

http:\\www.skyenet.net\~hussamd\index.html

Use Word 6.0c or later to           

view Macintosh picture.             



©1992-1997 Hussam Dandashli, Sheba Softpurr.  All rights reserved

2



Introduction

Truss 6.0 for PowerPC is an application that explores the behavior of planar trusses under
external loading.  It analyzes and displays the internal forces in the members using color 
intensities to denote force values.  The system requirements to run this application is a 
PowerPC machine with a color monitor.  If you have a non PPC machine please use 
version 5.2 which essentially has the same functionality.

Some of the features implemented cover:

∑ Create an arbitrary truss.
∑ Alter the geometry of an existing truss design interactively by moving the joint 

locations or by adding or removing truss members, truss supports or truss joints.
∑ Automatic check whether the truss is indeterminate or not.
∑ Apply loads on a truss, and then change their direction interactively.
∑ Produce free body diagrams of the entire truss or for selected pins.
∑ Produce a color graphical display of the load distribution in the individual 

members with the color (pattern) of the members denoting tension or 
compression.

∑ Implement Method of Joints to isolate members or nodes.
∑ Create QuickTime movies of a car traveling over the truss.
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Version History

New in version 6.0:

∑ PowerPC native version only.
∑ The application was rewritten in C++ using Symantec C++ visual architecture.  

Segments of the code did not fit in the 32K segment limit to produce a non PPC 
version.  Sorry.

∑ Balloon help is enabled.
∑ Shortcut buttons and the color scale reside on  floating pallets.
∑ Truss colors as well as background and foreground colors can be selected by the user.
∑ Pattern display has been disabled.  Only colors are available.
∑ The animation of the car traveling over the truss is done in a separate window.
∑ The entire truss can be moved with the mouse.
∑ Applied nodal forces can be assigned by double-clicking a node..
∑ The full version can be unlocked with a serial number instead of waiting for a full 

version.
∑ Some menu items were rearranged, and some were dropped altogether.
∑ When printing the truss will be resized to fit on one screen.
∑ The console window was dropped.  The forces text can be exported to a file when 

needed.
∑ Snap to grid functionality has been added.
∑ Method of sections has been dropped since the truss is analyzed automatically.  Only 

the method of joints will be used to display joint and/or supports free body diagrams.

New in version 5.2 include:

∑ PowerPC native application combined with a non-FPU 68k version (FAT) for 
better performance when dealing with large trusses.

∑ New implementation of the console window to enable scrolling and copying 
directly from the console (thanks to CodeWarrior™ SIOUX library).

New features in version 5.1:
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∑ The force vector length now reflects the relative magnitude of the force compared 
with the maximum force in the truss members or at the supports.

∑ Smooth updating of the main screen (Truss window).  Note that using a large 
window will now consume more of the application's RAM due to the allocation 
of an off-screen buffer.  Make sure that enough RAM is allocated.

∑ The color scale is displayed only when needed.
∑ The button shortcuts now only display possible options depending on the joint or 

member that is selected.
∑ Some popular roof and bridge trusses are now a permanent part of the application.
∑ Unlike previous versions, the joint limit can be dynamically increased (if enough 

memory is available) without restarting the truss design from scratch.
∑ The movie frames are displayed during the making of the movie, along with a 

progress bar.
∑ The force in any member can be displayed numerically when the mouse is held 

down as a member is selected.
∑ Resizable force list window.  The forces will be printed in rows which will resize 

whenever the window is resized.
∑ Other cosmetic improvements that deal with the user interface.
∑ Some parts of the code were re-written to enhance performance and fix some 

memory leaks and some bugs.
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Sample View

A sample truss design is shown in Fig. 0 as it would appear on the screen after 
performing the force analysis (in color mode or pattern mode).  The shortcut buttons have
been moved to a floating pallet shown on the left, the color pallet with modifiable colors 
is at the bottom in a floating pallet, and the force list is shown at the right.
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Fig. 0  Screen view of TRUSS 6 application in color mode.

The color scale for the members following the force analysis: red colors indicate tension, 
and blue colors indicate compression. Gray indicates negligible or zero loads (less than 
2% of the maximum member force).  The colors are re-assignable.  Click the button and 
choose a color from the color wheel.  The shortcut buttons are equivalent to selecting 
corresponding menus from the menu bar.  They represent the most utilized functions used
in building and analyzing a truss.
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Using Truss

Start the application by double-clicking on the application icon. 
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Fig. 1  Registering Truss.

If you have not registered the application and obtained a key, click OK or cancel to 
access the demo version.  The demo version is fully functional up to four nodes.
If you have a key enter it in uppercase and hit OK.  Remember that the application has 
balloon help for most fields and buttons.  Use it when in doubt.

Creating a Truss

This task is very simple:

1. Choose "Create Truss  " from "Edit" Menu.  This will produce a triangle on the 
screen.  The nodes (joints) can be moved with the mouse.
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Fig. 2. Creating a TRUSS .

Note that you have to provide the maximum number of joints that you intend to use
in order to efficiently allocate memory to the operation.  If you are not sure how 
many nodes you will need enter 30 nodes.  This is sufficiently large for most 
trusses.  You can increase the number of nodes dynamically later on if enough 
RAM is available to perform the operation.  Choose menu item "Node Limit..." 
from the "Truss" menu.

2. Select any two nodes by clicking on them individually, or click inside a member.  
The nodes will be selected (yellow).  If more nodes are selected, only the two most
recent ones will be selected.  This is useful for joining two unconnected nodes, or 
for removing an unnecessary link.
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Fig. 3. Selecting a member

3. Choose "Add Node " from "Truss" Menu (or use the shortcut button).  This will add 
a node and  connect it to the two selected nodes.  The nodes will be de-selected. 
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Fig. 4. Adding a node to a selected member.

4. The newly created node can then be moved by dragging it with the mouse (button 
down) to the desired location.
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Fig. 5. Moving the nodes to obtain the desired structure.

9



5. Subsequent addition of new members and joints is accomplished by repeating steps 2,
3, and 4.

6. A support can be applied to any selected node.  The buttons will reflect possible 
options only when one node is selected.  If a member is selected, click outside the 
truss to de-select all nodes and then click on the desired node.  

Use Word 6.0c or later to           

view Macintosh picture.             

Fig. 6.  Support buttons

7. Applying a force at a node is accomplished by first selecting the appropriate node 
followed by a click on the force option in the shortcut strip (apply/remove load).  
You can also get the dialog box by double clicking the node.
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Fig. 7.  Loading/unloading a truss

The apply force button (or double clicking) will bring up a dialog box to the screen 
prompting the user to enter the force magnitude and direction (in degrees and 
measured from a right-oriented horizontal line ccw). Type the desired numbers and
choose OK when done. Note that a positive force points away from the node, while 
a negative one will point towards the node.  
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Note: The dialog box will also come up if the node is double-clicked.
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Fig. 8. Loading/unloading a truss node.

Manipulating the truss

Several of the following options have shortcut buttons in the pallet:
1. Any node can be moved by clicking and dragging to a new location.
2. Any member may be removed by first clicking on the nodes of that member (or 

clicking on the member) and selecting “Remove Member” option in the “Truss ” 
menu.

3. A member may be added by selecting the two nodes where a new member is to be 
located followed by selecting “Add Member” option from the “Truss” menu.
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4. Any force (support) can be removed by first clicking on the node on which the force 
(support) is at, followed by clicking the remove force (support) shortcut button 
shown with the crossed icon. 

5. The grid can be of help while creating or manipulating the truss.  The “Align Truss 
Members ” option in the “Options” menu will correct any minor misalignments in 
the members.
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Fig. 9. Aligning the truss in case of minor misalignments.

6. The "Snap To Grid" option will move the nodes to the closest grid.  This is very 
helpful when designing a bridge truss where most of the members are at uniform 
distances from each other.  The grid spacing can be specified (in pixels) from the 
"Grid Spacing..." menu item.
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Fig. 10. Snapping the truss to the grid.

7. Dragging a node onto a member will add the node to that member, splitting it into 
two connected members. Also, moving a node close to another node will combine 
them into a single node.

8. The entire truss design can be discarded by choosing “Delete Truss“ from the 
“Truss“ menu.

9. The colors used to display member forces can be reassigned to any color of choice.  
Just click on the color in the color scale pallet and assign a new color.  The original 
color can be restored by selecting menu option “Default Color Scale” from the 
“Options” menu..
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Fig. 11. Changing the color scale.

10. The background color can be selected by the user.  Select “Background Color...” 
from the “Options” menu and select a new background color.
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Fig. 12. Changing the background color.

Analyzing the truss
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Once the desired truss has been created, the analysis step follows with several options: 

 1. Truss Solution:  Choose "Analyze Truss" Option from "Analysis" menu, or click the
solve button.  If the truss is solvable, the members will be drawn in different 
intensities of red (tension) and blue (compression).  Others colors could be specified
by clicking on the color box.  The forces in the members can be interpreted relative 
to the color scale. 
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Fig. 13. Analysis Mode.

 2. A free body diagram of the whole truss can be viewed by selecting " FBD Mode" 
option, or by clicking the FBD button.  This will return the truss to the wire frame 
mode (the truss has to be in color mode to access this option).  To get the FBD of the
truss click on any member. 
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Fig. 14. Free body diagram of the truss supports.

 3. A free body diagram of a joint can be displayed by clicking on it when in FBD Mode
as in bullet 2 above.  Force values can be forced to appear on the screen or disappear
by choosing either "Show Force Magnitude" or "Hide Force Magnitude" from the 
"Edit" menu . 
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Fig. 15. The free body diagram of a selected node.
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4. Member forces can be printed in a separate window if "Forces" was chosen from the 
“Windows” menu, a window will appear having all the applied forces, member 
forces, and ground reaction forces.  It can be exported to a text file, copied, and 
printed.
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Fig. 16. Another way of obtaining numerical results.

5. If the truss is over-constrained or under-constrained, a dialog box will appear with the
appropriate warning and the program will return to the wire-frame mode.
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Fig. 17. An improper truss missing a support (under-constrained)

6. The member width can be increased to make seeing the colors easier especially if 
used with overhead projectors.  Select “Member Width...” from the “Options” menu
and specify the width in pixels as shown below.
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Fig. 18. Changing the member width

7. When a truss is created an initial node limit has to be specified.  Choosing a low 
number that is sufficient to create the desired truss will help conserve memory.  The 
memory available can be obtained from the logo window (upper left corner).  This 
initial value can be increased provided there is enough memory available to perform 
the operation.  The application will ask you to save the truss as a precaution.  Please 
do so if you do not want to risk losing your design.  The application will guess how 
much memory will be needed and tell you to increase the memory partition of the 
application if needed.
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Fig. 19. Increasing the node limit
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Exporting Results

Truss 6  supports several result exporting options:

∑ The windows could be copied to the clipboard and pasted in other applications.

∑ The entire window can be exported as a PICT file from the "File" menu.

∑ A QuickTime movie can be created to simulate a car traveling on selected members.  
Select " Moving Load Simulation" from "Windows" menu to open the 
simulation window.  Note that the truss has to be in color mode before the 
simulation menu option can be enabled.  This is done to insure that the truss is 
solvable.
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Fig. 20. Animation window
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∑ Before the animation can be performed, you will have to initialize the options.  Note 
that if the truss is not centered, go back to the main window and move it there.  The 
animation window mirrors the main window.  Click the Options... button to initialize 
the animation parameters.
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Fig. 21. Animation options

∑ The Truss application can also show the animation in the window when the car button 
is clicked.  The car load is distributed between the nodes according to its distance 
from each node.  This is only an approximation. The resulting movie can be exported 
and viewed with any application that supports QuickTime format like SimplePlayer.
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Fig. 22. One of the animation frames
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∑ Steps of the numerical solution can be saved to a file named "Trace File" that can be 
read with any word processor.  The solution steps of the system of equations uses the 
Gauss-Jordan method with full pivoting for better accuracy and performance.
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Truss Menus
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Shortcut Buttons Pallet
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About The Author

The author of this application is Hussam A. Dandashli.  I graduated from Purdue 
University in 1993 with a BS and a MS in Mechanical Engineering.  This application was
my first attempt at C language and the Macintosh user interface.  Since then, I have been 
hooked on developing engineering, physics and mathematics applications in an attempt to
help students appreciate the concepts and not be concerned with solving equations.  I also
developed multimedia tutorials in Statics and Dynamics for Purdue University.
I am currently working as a software engineer at NIBCO Inc, Elkhart, IN.  I am involved 
in developing client/server applications using C, SQL, Oracle Database, PowerBuilder, 
and SAP ABAP/4 for PC and Unix platforms.
Many thanks to my wife for enduring my sleepless nights debugging, and to my professor
C. M. Krousgrill for guiding me in shaping the truss application, and for my cats Sheba, 
Burt, and Tabby for keeping my feet warm.
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